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Purchase Order Operations Guide 

Introduction 

Welcome to CertiflexDimension Purchase Order! 

This Operations Guide is designed to help you get started using the program. It is organized in a 

fashion for first time users and details the steps you need to follow once the system is installed. 

It can also be used as a reference to help you with day to day processing.    

To get the most out of CertiflexDimension Purchase Order and to guard against wasted 

definition time, it is very important that you read this guide and familiarize yourself with the 

product before you begin processing.   

This guide is used in conjunction with the CertiflexDimension System Manager Guide. The 

System Manager Guide details the CertiflexDimension terminology, functions, general program 

overviews, general program buttons, and fields. It also shows you how to: 

 Configure Users and Define System Security 

 Configure User Defined Memos 

 Change the Processing Date  

 Add Companies 

 Print Reports 

It is extremely important that you read the System Manager Guide before you begin using the 

Purchase Order for Windows program. 
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What You Need To Know First 

CertiflexDimension Purchase Order is used in conjunction with the CertiflexDimension 

Accounts Payable program. We strongly recommend that you read the Accounts Payable 

manual and define the Accounts Payable program before using the Purchase Order program. 

This version of CertiflexDimension is a Microsoft Windows® application. You must be familiar 

with Windows before you can use the Purchase Order program. 

Before you begin working, make sure that you have correctly installed CertiflexDimension 

Accounts Payable and Purchase Order on your computer.  The CertiflexDimension Accounts 

Payable program must be installed on your computer in order for you to use CertiflexDimension 

Purchase Order.  To install the programs, refer to the Installation Instructions included in your 

package. 

Start-Up Cycle 

You are ready to begin processing after you: 

 Install CertiflexDimension, 

 Read the CertiflexDimension System Manager Guide, 

 Read the Accounts Payable Operations Guide, 

 Read the Purchase Order Operations Guide, and 

 Add Companies to your System 

NOTE: If you are converting from CertiflexDimension version 9.0, you do not 

need to perform the start-up functions. 

Schedule of Events 

Please use the following Schedule of Events as a guide to using the CertiflexDimension 

Inventory program. 

 Order the Accounts Payable/Purchase Order forms: The system is preset to print purchase 

orders on plain, 8½ x 11” paper. This allows you to avoid the expense of obtaining pre-

printed purchase order forms or allows you to immediately begin printing purchase orders 

before your forms arrive. Enclosed with your CertiflexDimension program is a Certiflex 

Forms brochure for ordering purchase order forms. If you have any questions about the 

purchase order form or style, call Certiflex Forms directly at 800-544-3427. 

 Define the Master Data: After you have added a company to the system, you need to define 

the company's Master Data before you can begin processing. Refer to the Defining the 

Master Data section for a detailed explanation of this procedure.  

 Define the Purchase Codes: For each purchase order detail line you enter, the system will 

require you to specify a purchase code. Refer to the Maintain Purchase Codes section for a 

detailed explanation of this procedure. 

 Define the Purchasing Agents: For each purchase order entered, the system will allow you 

to specify a purchasing agent for that order. Refer to the Maintain Purchase Order Agents 

section for a detailed explanation of this procedure. 

 Define the Accounts Payable data: The Purchase Order program is used in conjunction 

with the Accounts Payable program. The Purchase Order program will not function 

without the proper definition of the Accounts Payable program. Be sure that you have 

defined all areas of the Accounts Payable program before using the Purchase Order 

program. 

 Define the General Ledger and Inventory data: If you are operating interactively with 

these programs, you will need to define these programs in addition to the Accounts Payable 

and Purchase Order programs before you begin processing in Purchase Order. 

 Make a backup: You have now added all of your Purchase Order information, and you are 

ready to begin normal processing. It is very important that you make a backup of the 

Purchase Order data files to guard against the possibility of losing your work. 
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Purchase Order Transaction Processing Cycle 

Purchase Order transaction processing is comprised of three specific steps.   

 Step 1: Record Purchase Order – Use this step to add, change and delete purchase orders.  

Purchase Order items that have been received but not vouchered cannot be edited.  Entire 

Purchase Orders with any items received but not vouchered cannot be deleted. 

 Step 2: Record Purchase Order Receipts – Use this step to record the receipt of items 

ordered. 

 Step 3: Record Purchase Order Voucher – Use this step to record vendor invoices for 

received items.    

A Purchase Order is considered complete once all items have been both received and vouchered. 
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Defining the Master Data – Purchase Order 

Company Master Data 

Company Master Data Settings allows you to configure the Purchase Order program to fit the 

individual company’s needs. The program is very flexible with respect to configuration, and the 

fields defined in this option are very important in regard to how the program will operate. 

Please read this section so that you may define the Master Data in the manner best suited for 

the company. 

To open the Master Data, click >File >Company Maintenance >Master Data 

Properties. Click >Purchase Order. 

 

Main 

Select the Main tab to define the following: 

 Name & Address: Enter or change the name of the company. This will be the company 

name the system will use when printing the purchase orders if the company name is not 

already pre-printed on the forms. 

 Inventory Interactive Status: Set this field to Interactive if you are operating 

interactively with the CertiflexDimension Inventory program. This allows you to enter 

inventory receipts as part of the receiving purchase orders process. If you are not operating 

interactively with the Inventory program or if you do not plan on recording inventory 

receipts during receiving purchase orders, set this field to Non-Interactive. 

 Accounts Payable Interactive Status: Accounts Payable is required for processing 

in CertifllexDimension Purchase Order.  You should always leave this option set to 

Interactive. 

 General Ledger Interactive Status: Set this field to Interactive if you are 

operating interactively with the CertiflexDimension General Ledger program. This allows 

you to record the Accounts Payable journal entry transactions as part of the receiving 

purchase orders process. If you are not operating interactively with the General Ledger 

program, set this field to Non-Interactive. 

 Default Tax Rate Percent: Enter the default tax percentage to use for taxable 

purchase orders. The system will allow you to override this percentage during purchase 

order entry. 
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 Print General Ledger on Voucher Summary: Select this check box if you want 

the system to print the General Ledger journal entry information on the Voucher Summary 

report. If you do not want this information printed on the Voucher Summary, do not select 

this check box. 

 Maintain PO Code History: Select this check box if you want the system to maintain 

a purchase code history file (data file PO4). If you select the check box, the system will 

allow you to print history reports of everything vouchered through the Purchase Order 

program in purchase code order. 

 Next PO Number: Each time you enter a purchase order, the system assigns the 

purchase order a sequential purchase order number, based on the number you specify here. 

The purchase order number is saved with each purchase order transaction in the 

transaction files. 

 PO Message One, PO Message Two: These fields allow you to enter any message 

that you would like the system to print on each purchase order. 

Aging 

Click the Aging tab to change the aging column calculations for the Anticipated Receipts 

Schedule report. When shipped, the system was set with defaults for the aging columns of 

Current, 31-60, 61-90, and Over 90. If the report aging columns need to be different, you can 

change the column definitions here. 

 

The system takes into consideration four items to determine the age of each purchase order: the 

aging criteria (as defined here), the expected receipt date of the purchase order, the payment 

terms assigned to each purchase order, and the processing date. 
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For example, if you are using the system’s default aging and you have the following purchase 

orders not yet received, 

 Purchase Order Number 147 

  Payment Terms: Net 30 Days From Invoice Date 

  Expected Receipt Date: 12/15/12 

  Commitment Value: $325.78 

  Anticipated Payment Date: 01/14/13 

 Purchase Order Number 184 

  Payment Terms: Net 20 Days From Invoice Date 

  Expected Receipt Date: 02/15/12 

  Commitment Value: $1,174.51 

  Anticipated Payment Date: 03/05/13 

Purchase Order Number 219 

  Payment Terms: Net 10 Days From End of Month 

  Expected Receipt Date: 04/01/12 

  Commitment Value: $2,824.62 

  Anticipated Payment Date: 05/10/13 

 

if you set the system date to 12/31/12 and print a commitment report, the aging of the 

Anticipated Cash Requirements Schedule would be: 

 

Current 31 to 60  61 to 90  Over 90    

 3325.78  $0.00  $1,174.51  $2,824.62 

 

 Heading Column One, Heading Column Two, Heading Column Three, 

Heading Column Four: These fields allow you to specify the aging column headings 

that will print on the Anticipated Receipts Schedule of the commitment reports. 

The system will allow you to enter anything that you would like for the headings. You will 

normally want to define each aging heading to correspond to the Oldest Invoice in Days 

fields. Otherwise the commitment reports may be difficult to understand because the 

system uses the Oldest Invoice in Days fields for aging calculations. 

Your input here is for printing and display purposes only. The system does not use your 

input here for aging calculations. 

 Oldest Invoice Column One, Oldest Invoice Column Two, Oldest Invoice Column 

Three: These fields allow you to specify what future aging category each commitment 

amount should go. 
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Maintain Lists – Purchase Order 

Maintain Purchase Codes 

This option allows you to add new purchase codes, change information on existing purchase 

codes, or delete purchase codes. 

The CertiflexDimension Purchase Order program uses purchase codes to allow a breakdown by 

type of purchase when you voucher invoices for received purchase order quantities. Purchase 

codes can be the same as purchase (or expense) accounts in the General Ledger chart of 

accounts, or they can be a further breakdown of these accounts. How you define the purchase 

code numbering scheme is entirely your choice. You may want to define purchase codes by 

department or division to track the purchases separately for various types of products. 

If you use the CertiflexDimension Accounts Receivable program, you will notice that purchase 

codes operate in a manner very similar to sales codes. 

When you add or change purchase orders, the system will ask you to enter a purchase code for 

each purchase order detail line. 

NOTE: If you are interactive with the CertiflexDimension Inventory 

program, each inventory item should have a purchase code defined on its 

record. The system will automatically use the item’s purchase code, allowing 

you to override it, when you use an inventory item on a purchase order detail 

line. 

It is very important that you be consistent in your use of purchase codes to allow the system to 

efficiently summarize all purchases in preparation for automatically displaying the voucher 

journal entry and printing the Purchase Code Listing report. 

You do not have to actually define a separate General Ledger account number for each purchase 

code you use in purchase order processing. Instead, you may define one General Ledger account 

number to be used by several purchase codes. 

When you installed the Purchase Order program, the system created five purchase codes for 

you: 

0001  Accounts Payable 

0003  Sales Tax 

0004 Freight 

0005 Adjustment 

0011 Default Purchase Code 

These five purchase codes are required by the system. The system will not allow you to delete 

these purchase codes. However, the system will allow you to change information on these codes. 
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Adding a Purchase Code 

To add a new purchase code, click >Maintain Lists >Purchase Order >Purchase 

Codes. 

 

To add a new purchase code, click >New. The system will prompt you for the following: 

 New PO Code: Enter the new purchase code number.  Click >Ok to continue creating 

the new purchase code. 

NOTE: To create a ZZ description only purchase code, enter a PO Code of 

ZZ## (ZZ00 - ZZ99).  

Click >Ok to continue to the Edit Purchase Code screen. 

 

 Description: Enter the description for this code.   

 Default Unit Price: If you define a default unit price, the system will automatically use 

this amount when this purchase code is used during the addition or changing of detail 

lines. This helps speed data entry during recording receipts. 

If this purchase code is used in conjunction with an inventory item, you do not need to 

define this field. The system will use the default unit price as defined for the inventory 

item. 
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 Default Unit of Measure: If you define a default unit of measure, the system will use 

this input when this purchase code is used during the addition or changing of detail lines. 

This helps speed data entry during recording receipts. 

If this purchase code is used in conjunction with an inventory item, you do not need to 

define this field. The system will use the default unit of measure as defined for the 

inventory item. 

 Taxable: Select this check box if this purchase code is always considered to be taxable. If 

this purchase code is tax exempt, do not select this check box. 

 General Ledger Account Number: If you are operating interactively with the 

CertiflexDimension General Ledger program, define the General Ledger account number 

for this purchase code. 

 Job Cost Code Number: If you are operating interactively with the 

CertiflexDimension Job Cost program, enter the job cost code number for this purchase 

code. 

Click >Save to add the new purchase code to the system. 

Changing a Purchase Code 

To change a purchase code, click >Maintain Lists >Purchase Order >Purchase 

Codes. 

When the Maintain Purchase Codes screen is displayed, enter the purchase code to change in 

the Search. Once the purchase code you want to change has been selected, click >Edit or 

simply double click on the desired code in the listing.  The system will display the Edit Purchase 

Code screen for the selected purchase code. For detailed information on each field displayed, 

refer to the Adding a Purchase Code section. 

Deleting a Purchase Code 

To delete a purchase code, click >Maintain Lists >Purchase Order >Purchase 

Codes. 

When the Maintain Purchase Codes screen is displayed, enter the purchase code to delete in the 

Purchase Code field. When a valid purchase code is entered, the system will display the 

information for the selected purchase code. To delete this purchase code, click >Delete. 

NOTE:  The system will not allow you to delete the pre-defined purchase 

codes. These are codes 0001, 0003, 0004, 0005, and 0011. 

Maintain Purchase Order Agents 

This option allows you to add, change, and delete the purchasing agents. Purchasing agents are 

representatives or entities of your company that will be making purchases. You may define 

purchasing agents as individual employees of your company or departments of your company. 

The system allows you to maintain purchasing agents so you can track who placed each order. 

This is an optional feature and is not required by the system for the proper operation of the 

program. 
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Adding a Purchase Order Agent 

To add a new purchase order agent, >Maintain Lists >Purchase Order >Purchase 

Agents. 

 

When the Maintain Purchase Agents screen is displayed, click >New. The system will prompt 

you for the new purchasing agent number. This field can be alphanumeric with no more than 

three characters in length. 

Click >Ok to continue to the Edit Agent screen.  

 

 

 

To add the name for the new agent, enter their name in the Agent Name field.  Click >Save to 

add the new agent to the system. 

Changing a Purchase Order Agent 

To change a purchase order agent, click >Maintain Lists >Purchase Order >Purchase 

Agents. 

When the Maintain Purchase Agents screen is displayed, select the agent you wish to change 

and click >Edit or simply double-click on the agent you wish to change and enter a new name for 

this agent.  The system will display the Edit Agent screen.  Make any desired changes and then 

click >Save. 

Deleting a Purchase Order Agent 

To delete a purchase order agent, click >Maintain Lists >Purchase Order >Purchase 

Agents. 
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When the Maintain Purchase Agents screen is displayed, select the agent you wish to delete and 

then click >Delete. 
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Transactions - Purchase Orders 

Record Purchase Orders 

This option allows you to record purchase orders. You can add, change, and delete purchase 

orders. The input of purchase orders is normally the first step you perform in the purchase 

order entry process. 

NOTE: If you are operating interactively with the CertiflexDimension 

Inventory program, purchase order validation will update the quantity on 

order for each inventory item included in the purchase order. 

Recording a Purchase Order 

To record a purchase order, click >Transactions >Purchase Order >Record 

Purchase Orders.  The system will display the Select Vendor & Start Transactions screen. 

 

Open Orders 

Under the Vendor’s Open Orders tab, you can perform the following options: 

 Edit: Select an open purchase order and click the >Edit button to make changes to the 

selected order. 

 Delete: Select an open purchase order and click the >Delete button to delete the selected 

order.  The system will then launch the Purchase Order Listing, displaying all open items.  

Double-click on the order you wish to delete and the system will prompt you for 

confirmation before deleting the open order. 

 Repeat: Select an open purchase order and click the >Repeat button to create a new 

purchase order that has the same header and detail of the selected order. 

 Close: Select an open purchase order and click >Close to close and delete the selected 

order. The system will prompt you for confirmation before closing and deleting the open 

order.   
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NOTE: The Purchase Order system tracks two separate lists of orders.  All 

open orders, received orders and partially complete orders are tracked in the 

“Open Order” file.  All closed orders are tracked in the “Closed Order” file.  

The Purchase Order system automatically removes orders from the “Open 

Order” file when you fully voucher a completed order.  You may manually 

close an “Open” or “Partial” order by clicking >Close.  Once an order has 

been manually closed, it may not be re-opened. 

 Recalculate: This option will recalculate all open orders and reset each order’s status. If 

you are interactive with the CertiflexDimension Inventory program, the system will also 

reset each inventory item’s Quantity on Order. 

NOTE: This option requires a supervisor’s level 10 security access. Also, all 

other users should be logged out of both CertiflexDimension Purchase Order 

and Inventory programs before executing the Recalculate process. 

Closed Orders 

Under the Vendor’s Closed Orders tab, you can perform the following options: 

 Repeat: Select a closed purchase order and click the >Repeat button to create a new open 

purchase order that has the same header and detail of the selected order. 

 

Default Settings 

 Pre-Assign Order Number:  Click this option if you would like to assign a purchase 

order number before entering the purchase order. Typically, a purchase order number is 

assigned to the purchase order once the purchase order is validated. However, you may 

have situations where you need the purchase order number before you have completed the 

purchase order. If this is the case, you can click this option to cause the system to assign a 

purchase order number to this purchase order prior to validation. 

NOTE: The next purchase order number will be incremented even if you do 

not save this order. 

 Vendor/Item Number Checking:  Select this checkbox if you want the 

system to verify that the inventory items listed in the purchase order are 

associated with their preferred vendor(s).   

If the Vendor/Item Number Checking feature is enabled and you record a 

purchase order using a vendor that is not set as “preferred” in the 

selected inventory item’s Purchase settings, the system will notify you of 

this and display the following confirmation screen before continuing: 

 

For more information on setting an inventory item’s preferred vendors, 

please refer to the >Maintain Inventory Items >Add Inventory Item 

>Additional Options >Purchases section of the CertiflexDimension 

Inventory Operations Guide. 

 Email Confirmation After Printing: Click this option if you would like to 

automatically email a confirmation of your orders to your venders after new purchases 

orders have been validated and printed. If you select this option, a PDF copy of will 

automatically be attached to your emails. This option will be active only if you have 

selected to print orders after saving. 

NOTE: The system has default wording used in the email confirmation 

system.  If you would like to change either the default email subject or body, 

please contact Customer Service for assistance. 
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 Print Order After Save: Select Yes, No or Prompt depending on if you 

want the system to automatically print each Purchase Order after saving. 

Selecting the Prompt option will force the system to ask if you wish to 

print each time an order is saved.  

 Selected Form: This selection displays the Order form currently selected to print. To 

print a different format, click >Change Form. 

 Selected Printer:  This section displays the printer currently selected to print.  To use a 

different printer, click >Change Form >Printer Setup…. 

 Change Form: Select this option to change the default order form or 

printer.  

o Order Form:  This displays the currently selected order form.  To 

select a different form, click on the down arrow for a list of available 

forms 

o Output: This section allows you to define where the purchase order will print. 

 Selected Printer: Select this check box if you want the system to print the 

purchase order to the selected printer. 

 Preview Screen: Select this check box if you want the system to print the 

purchase order to screen. 

NOTE: The system will allow you to select both check boxes. If you want to 

review a report to screen first and then want to print a copy, the system will 

allow you to do so from the preview screen. In addition, when printing from 

the preview screen, you can print a range of pages instead of printing the 

complete report. 

o Copies: Enter the number of copies of this purchase order you want printed. 

o Printer Setup…: This button allows you to select which printer to print the 

purchase order to. The system will default to your Windows default printer. If you 

want to change the printer for this purchase order, click Printer Setup… and select 

the printer from your Windows printer selection list. 

o Clipboard: If you want to have the system automatically copy the 

vendor fax number or vendor email address to the Windows Clipboard 

for manually sending a fax or email, select either Fax Number or 

Email Address for this option. 
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Adding New Purchase Orders 

 Vendor:  Select the vendor to record the voucher for.  You can press F5 to switch the vendor 

index (i.e. Vendor Name to Vendor Number) or press F6 to display a list of vendors. 

 Start:  When a valid vendor is selected, you must click >Start to access the remainder of the 

record voucher screen.  

Hint: You can optionally scroll through your vendor list by pressing the 

up/down arrows.  You can display your vendor list by pressing [F6], or 

clicking the flashlight icon.  You can optionally switch the vendor index 

between vendor name and vendor index by pressing [F5].  New vendors can 

be added by pressing [F6] and clicking >Add New. 

When you click >Start, the system will display the Record Purchase Orders screen and prompt 

you for the following: 

 

Vendor Information{v10New} 
Ship To: Enter the ship to Name and address for this order.  You may optionally various lookup lists for entering Purchase Orders 

not shipped to the primary delivery address.  Four selectable options are available in this Ship To feature.  Each option can be 

activated by clicking the appropriate delivery truck icon.  The option will then present a full list.  Selecting an item from the list will 

extract the ship to address for the selected item or location.   

 

   Red Truck – Ship To – Customer List 

If you have CertiflexDimension Accounts Receivable, you can use this option to present a list of customers.  This list will 

use the “Ship To” address from the selected record.  If the “Ship To” address for this customer is blank, the system will 

use the regular customer address. 

   Yellow Truck – Ship To – Customer ShipTo Key List 

If you have CertiflexDimension Accounts Receivable, you can use this option to present a list of customers.  Once you 

select a customer, the system will display a list of Ship To Keys for the selected customer.  This list will use the address 

from the selected record. 

   Green Truck – Ship To – Open Sales Order List 

If you have CertiflexDimension Order Entry, you can use this option to present a list of open Sales Orders.  Once you 

select an order, the list will use the “Ship To” address from the selected record.  If the “Ship To” address for this record is 

blank, the system will use the “Bill To” address from the selected record. 

   Brown Truck – Ship To – Job Locations List 
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If you have CertiflexDimension Job Cost, you can use this option to present a list of Jobs.  Once you select an order, the 

list will use the job locations lines from the selected record. 

 

Hint:   If you have multiple warehouse addresses used for delivery of inventory, you may wish to set-up an inactive 

customer in Accounts Receivable and use that customer’s ship to keys to hold your various warehouse 

addresses.  

Transaction Heading 

 Order Description: Enter a description for this purchase order. The system will allow 

you to index on this field when you record receipts, voucher purchase orders, etc. This 

allows you to access the purchase orders by either the purchase order number or the 

purchase order description. 

 Contact: Enter the vendor’s main contact. The system will default to the vendor’s contact 

defined on the vendor’s account. This field is used by the system as a memo field and will 

appear on the purchase order review screen. The system will print the Contact field as 

the first line of the remit to address. 

 Special Instructions: Enter any message that you would like to print on the purchase 

order. 

 Transaction Terms: The system will default to the vendor’s defined terms on the 

vendor’s main record. If you want to select a term other than the vendor’s default, select 

from the following: 

o Select Days from Invoice Date: Select this option if the invoice from this 

purchase order will be due a set number of days after the invoice date. If you select 

this option, the system will prompt you for the following: 

 Number of Days Until Due: Enter the number of days after the invoice date 

that the purchase order is due. 

 Discount Percent: If a discount percent for early payment is allowed by the 

vendor, enter the allowed discount percentage. 

 Number of Discount Days: If you entered a discount percentage above, 

enter the maximum number of days from the invoice date that you must pay the 

invoice in order to receive the discount. 

o Select Days from End of Month: Select this option if the invoice from this 

purchase order will be due a set number of days after the end of the month. If you 

select this option, the system will prompt you for the following: 

 Number of Days from End of Month: Enter the number of days after the 

end of the month that the invoice for this purchase order is due. 

 Discount Percent: If the vendor allows a discount percent for early payment, 

enter the allowed discount percentage. 

 Number of Discount Days: If you entered a discount percentage, enter the 

maximum number of days from the invoice date that you must pay the invoice in 

order to receive the discount. 

o Select Batch Number: Select this option if you will pay the invoice for this 

purchase order in a batch. If you select this option, the system will ask you for the 

batch number. The system will allow you to define up to 99 different batches. 

o Specified Due Date: Select this option if you want the invoice for this purchase 

order to be due on a specific date. If you select this option, the system will prompt you 

for the due date when the purchase order is recorded. 

o Suspense: Select this option if you want to place the invoice for this purchase order 

in suspense. An invoice for a purchase order placed in suspense is not considered for 

payment until its due date is rescheduled to a valid date. 

o Next Run: Select this option if you want to pay the invoice for this purchase order 

the next time you do a check run after the purchase order is invoiced, regardless of 

when the purchase order is due. 

 Purchasing Agent: If a purchasing agent is associated with this purchase order, select 

the purchasing agent. If a purchasing agent is not associated with this purchase order, 

leave this field blank or select House Purchases. 

 If you select a purchasing agent, the system will print the purchasing agent information on 

the purchase order. 
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 Phone Number: Enter the vendor’s phone number. This would be the number to call if 

you have a question about the purchase order. 

 Cancel Date: If you want this purchase order to be canceled if it is not received complete 

by a certain date, enter that date here. This is an informational field and is not required. 

 If you define a date here and the purchase order is not received complete by the defined 

date, the system WILL NOT automatically delete the purchase order. This field is for 

informational purposes only. You must manually delete/close the purchase order. 

 Auto-Receive: Select this option if you have already received all items for this Purchase 

Order and wish to automatically record receipts for this new Purchase Order on validating. 

This option is not active during Edit Purchase Orders.  

When the Transaction Heading fields are complete, click the [F9] Edit Detail button or 

select the Transaction Detail tab to enter the transaction detail lines. 

TIP: You can press [F9] to proceed to the Transaction Detail tab.  While in 

the Record Purchase Orders screen, pressing [F9] will toggle between the 

Transaction Heading and Transaction Detail tabs. 

 

Transaction Detail 

There are three types of transaction detail line items you can enter from this screen: 

Description Only Lines, Non-Inventory Detail Lines and Inventory Detail Lines. There are also 

special purchase order functions for changing the tax information and changing the freight 

amount from this screen. 
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Description Only Lines 

The system allows you to enter description only lines to the purchase order. You can use 

description only lines to add further information on the purchase order about a line item 

entered, or to print pre-defined description only lines. 

To enter a description only detail line, select Type 0.  

 

 Code: To select a pre-defined description, select a code from 0-99. For more information 

covering description only codes, refer to the Maintain Purchase Codes section. 

 Description: Enter the description to add to the purchase order. If you need to enter 

more than one line of information, click the  button.   

When the description only detail line item information is entered, click >Accept Line to 

validate the detail line item. 
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Non-Inventory Detail Lines 

Non-Inventory detail lines include all detail line types except for lines involving specific 

inventory items maintained in the CertiflexDimension Inventory program and description only 

lines. 

To enter a non-inventory detail line, select Type 1. The system will allow you to enter the 

following information: 

 

 Code: Select the desired purchase code to use. 

 For every purchase order line, the system requires you to select a purchase code. The 

purchase code indicates the type of purchase for the current purchase order line. When you 

record an invoice for the purchase order (after the purchase order quantities are received), 

the system will automatically display a voucher journal entry for you. This journal entry is 

based on the General Ledger account numbers defined for each of the purchase codes used 

in Purchase Order. 

 Unit of Measure: Enter the detail line’s unit of measure. If the purchase code you used 

is defined with a default unit of measure, the system will automatically insert the default 

unit of measure in this field. The system will allow you to change the default for this detail 

line, if necessary. 

 Quantity Ordered: Enter the quantity to order for this detail line. The system requires 

that you enter a quantity greater than 0. 

 Unit Price: Enter the individual unit price for this detail line item. If the purchase code 

you used is defined with a default unit price, the system will display the default unit price 

in this field. The system will allow you to change the default unit price for this detail line, if 

necessary. 

 When a unit price is entered, the system will update the Extended Price field 

automatically. 

 Description: Enter the description for this detail line. The system will default to the 

description of the purchase code you used for this detail line. To enter additional 

description information, click the  button. You can enter up to 60 characters per line.  
 Expected Receipt Date: Enter the date that you expect to receive this line item. If you 

do not know, or do not wish to enter an expected receipt date, leave this field blank. 
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 If you enter an expected receipt date on the first detail line item, the system will assume 

the same expected receipt date for all remaining detail lines of this order. The system will 

allow you to change this date on the other detail lines, if necessary. 

 Job No.: If you are operating interactively with CertiflexDimension Job Cost you may 

enter a valid Job Number for this detail line.   

When all the detail line item information is entered, click >Accept Line to validate the detail 

line item. 
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Inventory Item Detail Lines 

The system allows you to enter detail lines for the purchase of inventory items, if you are 

operating interactively with the CertiflexDimension Inventory program. When you enter an 

inventory item detail line, the system will retrieve the inventory item’s information from the 

inventory data files and will also update the inventory data files for receipts of the item when 

you record receipts. 

To enter an inventory item detail line, select Type 2. 

 

 Inventory Item: Select the desired inventory item for this detail line. 

 Location: If the Inventory program is operating with multiple locations, select the 

location where the inventory item you wish to purchase will be located. The system will 

default to Location 1. 

 Code: Select the desired purchase code. 

 For every purchase order line, the system requires you to select a purchase code. The 

purchase code indicates the type of purchase for the current purchase order line. When you 

record an invoice for the purchase order (after the purchase order quantities are received), 

the system will automatically display a voucher journal entry for you. This journal entry is 

based on the General Ledger account numbers defined for each of the purchase codes used 

in Purchase Order. 

 Unit of Measure: The system will display the unit of measure defined for this inventory 

item on the item’s main inventory record. 

 Quantity Ordered: Enter the quantity to order for this detail line. The system requires 

that you enter a quantity greater than 0. 

 Unit Price: Enter the individual unit price for this detail line item. The system will 

display the last unit price saved for this item. You can press F4 to display a history of 

prices for this item. The system will allow you to change the unit price for this detail line, if 

necessary. 

 When a unit price is entered, the system will update the Extended Price field 

automatically. 

 Expected Receipt Date: Enter the date that you expect to receive this line item. If you 

do not know or do not wish to enter an expected receipt date, leave this field blank. 
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 If you enter an expected receipt date on the first detail line item, the system will assume 

the same expected receipt date for all remaining detail lines of this order. The system will 

allow you to change this date on the other detail lines, if necessary. 

 Job No.: If you are operating interactively with CertiflexDimension Job Cost you may 

enter a valid Job Number for this detail line.   

When the detail line item information is entered, click >Accept Line to validate the detail 

line item. 
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Changing Existing Detail Lines 

To change an existing detail line item for the current transaction, double-click on the desired 

detail line item in the Detail Listing and Transaction Totals screen. You can change any field 

and then click >Accept Edit to validate the changes. 

Note: If you are editing an existing order, you cannot edit detail lines that 

have been received but not vouchered. 

Deleting Existing Detail Lines 

To delete a detail line item from the current transaction, select the detail line item in the Detail 

Listing and Transaction Totals screen and press the [Delete] key on your keyboard.  A 

prompt will be displayed, confirming that you want to delete the selected line. 

Note: If you are editing an existing order, you cannot delete detail lines that 

have been received but not vouchered. 

Additional Options 

The system includes a variety of additional options that are available during the addition of 

purchase orders. These options are found by clicking Options. 

 Insert New Detail Line: Select this option to insert a new detail line item between 

existing line items. To use this option, select the detail line item in the Detail Line Item 

Listing screen you want a new line inserted above, click Options, and then click Insert New 

Detail Line. 

 Edit Additional Description: Select this option to edit the additional description for 

the selected detail line. To use this option, select a detail line in the Detail Line Item 

Listing screen, click Options and then select Edit Additional Description. The system will 

then allow you to edit or add additional description information for the selected detail line 

item. 

These options are found in the summary fields located in the lower right corner of the 

Transaction Detail screen: 

 Tax: When you select this option, the system will prompt you for the following: 

o Taxable Order: Select this check box if this purchase order is taxable. 

o Tax Rate: Enter the tax rate for this order. 

 Freight: Select this option to add a freight amount to this order. 

Note: If you do not enter a freight amount when adding the purchase order 

or if you enter the freight amount incorrectly, the system will allow you to 

add a freight amount or override the entered freight amount while recording 

receipts. 
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Adding Order Memos  

The Memos  button allows you to maintain information that is not already captured on each 

purchase order.  Memos can be used to track special reminders, discounts, secondary contacts, 

etc.   

You can add Memos while recording purchase orders. The headings for the memo lines are 

defined in the Maintain Memo Names supervisor option. To access Maintain Memo Names from 

the CertiflexDimension System Manager screen, click >File >Supervisor Options >Maintain 

Memo Names. 

NOTE: You must have Supervisor rights (access level 10) to be able to modify 

the memo headings in the Configure Memos options. 

Each memo line can be assigned an access level (1-10). If you do not have an access level equal 

to or greater than the one assigned to the memo line, you cannot edit the memo line. 

 Memo Lines: If you have access to the memo lines, enter the information in each 

appropriate field. 

Refer to the CertiflexDimension System Manager Guide for more information on configuring 

memos. 

Adding Order Notes  

The Notes  button allows you to organize and access information about purchase orders from 

one location.  Notes can be used to document disputes, incomplete order information, etc.  

You can add and review notes while recording or reviewing purchase orders. For detailed steps 

on adding notes, refer to the CertiflexDimension System Manager Guide.   

Adding Order Links  

The Links  button allows you to organize and access information about purchase orders from 

one location.  Links can be used to connect to vendor web sites, drawings, and online order 

systems. 

You can add and review links while recording or reviewing purchase orders. For detailed steps 

on adding links, refer to the CertiflexDimension System Manager Guide.   

Saving and Printing Purchase Orders 

When all detail line items are entered, click Save to add the order.  A purchase order form may 

be printed or emailed after validating if you have activated these options. 
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Changing a Purchase Order 

To change a purchase order, click >Transactions >Purchase Order >Record 

Purchase Orders. 

At the Select Vendor & Start Transactions screen, select the order you want to change from the 

Vendor’s Open Orders listing and click >Edit Order.  When a valid purchase order is selected, 

the system will display the information for the selected order. For detailed information on each 

field displayed, refer to the Recording a Purchase Order section. 

NOTE: You can also select an existing Purchase Order to edit by selecting 

the vendor and double clicking the desired order from the vendor’s previous 

order List. 

Deleting a Purchase Order 

To delete a purchase order, click >Transactions >Purchase Order >Record 

Purchase Orders. 

At the Select Vendor & Start Transactions screen, click >Delete Order.  The system will then 

open the Purchase Order Listing screen, displaying all open orders for all vendors. Double-click 

on the purchase you wish to delete and the system will prompt you for verification. 

NOTE: You cannot delete a Purchase Order that has been received but not 

vouchered. 

Repeating a Purchase Order 

To repeat a purchase order, click >Transactions >Purchase Order >Record 

Purchase Orders. 

This option allows you to copy a previous purchase order’s information to the new purchase 

order. This is useful when you have similar orders. To use this option, select the vendor and 

highlight the desired order from either the Vendor’s Open Order or Closed Order list and then 

click >Repeat Order.  The system will then open the Record Purchase Orders screen, with the 

heading and detail information copied from the original order. 

Closing a Purchase Order 

To close a purchase order, click >Transactions >Purchase Order >Record 

Purchase Orders. 

This option allows you to close and delete an open purchase order. To use this option, select the 

vendor and highlight the desired order from the Vendor’s Open Order and then click >Close 

Order.  The system will prompt you for confirmation before closing and deleting the order. 
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Record Receipts 

This option allows you to enter the quantity for each purchase order detail line that was 

actually received. To record receipts, you should first print the Receiving Reports and give them 

to your receiving department personnel. When the receiving department personnel receives 

stock items as detailed on the receiving reports, they should mark the quantity of the items 

ordered that were actually received on each receiving report detail line. When they have 

finished receiving the order, the personnel should return the marked up Receiving Report to you 

so you can use the information for recording receipts. 

If you are operating interactively with the CertiflexDimension Inventory program, the system 

will update the inventory items in Inventory when you record receipts. 

To record receipts, click >Transactions >Purchase Order >Record Receipts. 

 

 Purchase Order: Enter the purchase order number to record its receipt and then click 

>Start.  To select a purchase order from the Purchase Order Listing, click on the spyglass 

 or press [F6].  

 Freight Charge: Enter or change the previously entered freight amount for this 

purchase order. 

 [F4] Receive Complete: If the entire purchase order was received complete, you can 

click this button to cause the system to automatically mark the entire order as received. 

 [F5] Undo all Received Lines: Click this option if you wish to clear all previously 

unvouchered receipts for this order. 

If the order is not received complete, you will need to record receipts on a line by line basis for 

both the detail line items and for any description only lines. 

To record receipts for a detail line item, double-click on the individual line item. The system will 

prompt you for the quantity received for that line item. Enter the amount and click >Ok. 

Continue until all received line items are recorded. 
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NOTE: We do not recommend that you enter a quantity received that is 

greater than the quantity needed. If you actually received more of an item 

than was originally entered on the purchase order, you should change the 

quantity for the line item to the correct amount through Record Purchase 

Orders. If you record receipts for a detail line for an amount greater than the 

quantity needed and you are interactive with the CertiflexDimension 

Inventory program, the system will update the inventory item’s ‘Quantity On 

Order’ to be incorrect. 

The system handles the recording of receipts for description only lines a little differently. Until 

it is recorded as received, even partially, you can never print a description only line on vouchers 

for received orders. Description only lines are often used to extend the description for a 

particular order line. Therefore, you need a way to control when the description only lines will 

print on the vouchers generated for the order when the order line is recorded as received. In the 

event that the order line with which a description only line belongs is partially shipped, you also 

need to be able to control whether the description only line will appear only on the first voucher 

generated or also on subsequent vouchers generated for the order. 

When you double-click on a description only line item, the system will prompt you for the 

following: 

 

 Show Description Line on Report and Keep for Future Printing: If this 

order is not received complete, select this option if you want the description only line to 

print and you also want to retain the description only line for future printing. 

 Show Description Line on Report and Delete from Future Printing: Select 

this option if you want the description only line to print but you do not want to retain the 

description only line for future printing. You would select this option if the order or line 

item was received complete. 

 Do NOT Show Description Line on Report: Select this option if you do not want 

the system to print the description only line. 

When the selected purchase order is received complete or received per the receiving report 

notations, click >Save to save and record the receipt. 

 Show Detail Lines: Click this button to perform additional functions: 

o All Detail Lines: You should always use this option when you are recording receipts 

if you want to record the description only lines as received as well as the detail line 

items. 

o Backorder Only: You should use this option to record receipts when you want the 

system to access only purchase order line items that have not been completely 

received. This means the system will only access purchase order line items for receipts 

that have a quantity on order. 

 Find Next: Click this button and the system will automatically find the next available 

order. 

 Review Receipt Log: Once you save the first record receipt entry, the system will 

activate the Review Receipt Log button.  Click this button to see a review of the 

receipts recorded during the current session.  

When you exit the Record Receipts screen, the system will prompt you to print the Receiving 

Log report. 
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Record Purchase Order Vouchers 

This option allows you to voucher the invoices you received from vendors for purchase order 

items received. Until all purchase order quantities are entered as received and this process is 

performed for a purchase order, the purchase order is considered outstanding by the system. 

When this option is performed, the invoice is vouchered into the Accounts Payable system 

automatically and the General Ledger accounts affected by the voucher are also updated, if you 

are operating interactively with the CertiflexDimension General Ledger program. 

NOTE: When you perform this option, the system will voucher invoices for 

received purchase orders and create an open item for each vendor that a 

voucher was entered for. DO NOT voucher invoices through Record 

Vouchers in the Accounts Payable program for purchase order lines. If you 

do, you may duplicate open items for the vendors. 

When you validate a voucher, the system will automatically assign it a sequential voucher 

number based on the next voucher number defined in the Accounts Payable Master Data. As 

voucher transactions are validated, the system immediately updates the Purchase Order file. 

When you perform the voucher process, the applicable lines on the purchase order are marked 

as complete. 

The system will also update the following files: 

 The Vendor File: Voucher transactions normally increase the vendor’s account balance and 

add one or more lines to the vendor’s open items listing. 

 The Vendor History File: The invoices included in the voucher are added to the vendor’s 

history file. 

 The Accounts Payable Transaction File: This file is used by the Accounts Payable system 

to print the Voucher Register report. 

 The Inventory File: If you are operating interactively with Inventory, when you voucher 

invoices for purchase orders received and you made changes to the unit price of received 

Inventory items, the system will make adjusting entries to the Inventory history and cost 

information. 

 The General Ledger File: If you are operating interactively with General Ledger, validation 

of a voucher transaction will cause the voucher journal entry to be updated to the General 

Ledger files. This journal entry will normally consist of a debit to one or more asset or 

expense accounts, and a credit to the Accounts Payable account. 
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Recording a Purchase Order Voucher 

To record purchase order vouchers, click >Transactions >Purchase Order >Record 

Purchase Order Vouchers. 

 

 Purchase Order Number: Select the purchase order to voucher and click >Start.  To 

select a purchase order from the Purchase Order Listing, click on the spyglass  or press 

[F6]. 

 Invoice Date: Enter the date of this invoice. The system will use this date to calculate 

the due date of the open item. 

 The system will default to the current processing date. If you are vouchering the purchase 

order several days after they are received, be sure to change the invoice date to the correct 

date. When you pay this invoice, the system can optionally print this date on the vendor’s 

check stub. 

NOTE: The system will allow you to enter a prior period date. The system 

will not allow you to enter a future period date. 

If you enter a prior period date, the system will update the invoice 

information to the Accounts Payable files and to the vendor based on the 

date entered for the invoice date. The system will update the General Ledger 

accounts based on the current processing date. This can make balancing the 

General Ledger accounts payable account to the Accounts Payable program 

difficult. 

If you enter a prior period invoice date that is also in the prior fiscal year, 

the system will not perform the end-of-month calculations correctly. For 

these reasons, we recommend that you always use the current processing 

period invoice date. 
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If you need to voucher a purchase order for the prior period, we recommend 

that you exit this program, change the current system date to the prior 

period, and restart Record Purchase Order Vouchers. 

 Invoice Number: Enter the vendor’s invoice number. If Check For Duplicates is 

selected and you enter a duplicate invoice number, the system will display a warning 

message when you click Accept. You can have the system automatically check for 

duplicate transaction numbers by clicking Options and then clicking Check For 

Duplicates. 

 The system will save the invoice number to the open item created for this invoice. When 

this invoice is paid, the invoice number is printed on the vendor’s check stub. 

 Transaction Description: Enter the description for this voucher. 

 Transaction Payment Terms: The system will default to the payment terms defined 

when the purchase order was entered. You may change the terms here, if necessary. 

o Select Days from Invoice Date: Select this option if the invoice from this 

purchase order will be due a set number of days after the invoice date. If you select 

this option, the system will prompt you for the following: 

 Number of Days Until Due: Enter the number of days after the invoice date 

that the purchase order is due. 

 Discount Percent: If a discount percent is allowed by the vendor for early 

payment, enter the allowed discount percentage. 

 Number of Discount Days: If you entered a discount percentage, enter the 

maximum number of days from the invoice date that you must pay the invoice in 

order to receive the discount. 

o Select Days from End of Month: Select this option if the invoice from this 

purchase order will be due a set number of days after the end of the month. If you 

select this option, the system will prompt you for the following: 

 Number of Days from End of Month: Enter the number of days after the 

end of the month that the invoice for this purchase order is due. 

 Discount Percent: If the vendor allows a discount percent for early payment, 

enter the allowed discount percentage. 

 Number of Discount Days: If you entered a discount percentage above, 

enter the maximum number of days from the invoice date that you must pay the 

invoice in order to receive the discount. 

o Select Batch Number: Select this option if you will pay the invoice for this 

purchase order in a batch. If you select this option, the system will ask you for the 

batch number. The system will allow you to define up to 99 batches. 

o Specified Due Date: Select this option if you want the invoice for this purchase 

order to be due on a specific date. If you select this option, the system will prompt you 

for the due date when you click Accept. 

o Suspense: Select this option if you want to place the invoice for this purchase order 

in suspense. An invoice for a purchase order placed in suspense is not considered for 

payment until its due date is rescheduled to a valid date. 

o Next Run: Select this option if you want to pay the invoice for this purchase order 

the next time you do a check run after the purchase order is invoiced, regardless of 

when the purchase order is due. 

 [F5] Edit Quantities and Prices: Select this option if you have received an invoice 

with either quantities or prices that are different from the amounts previously recorded. 

When you select this option, the system will display a list of all active lines for this order. 

To change a single line, highlight the desired line and click Edit Line. To change all lines 

click Edit All Lines. Once all lines have been adjusted, click Close to return to the main 

voucher window. 

NOTE: The system will allow you to change the extended price instead of 

the unit price to avoid any possible rounding errors that could arise from 

partial quantities received. Since the vendor is more than likely displaying 

the total amount owed for a line item on his invoice instead of the unit price 

for each item owed, the system prompts you to change the total amount 

owed for each line item instead of the unit price of each item. You may also 
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use a “Quick Key” to change a voucher quantity for individual lines to zero.  

Instead of manually selecting the “Edit Quantities and Prices”, then picking 

each individual line that was not invoiced and then changing that line’s 

quantity vouchered to zero, you can select a line that is not invoiced and 

press the ‘F4’ key.  The system will automatically change the selected line 

quantity vouchered to zero. 

 Tax: If the tax amount charged on the invoice is different from the calculated tax amount 

of the invoice enter the correct tax amount here. If you manually change the tax amount, 

the system will discontinue the automatic tax calculation for this order.  To activate tax on 

a transaction set to non-taxable, use the [Ctrl+R] option. 

NOTE: If you are operating interactively with the CertiflexDimension 

Inventory program, tax amounts do not affect the inventory cost for 

inventory detail lines included. 

 Freight: If the freight amount charged on the invoice is different than the freight amount 

entered when the purchase order was added, enter the correct freight amount here. 

 If you are operating interactively with the CertiflexDimension General Ledger program, 

when a freight amount is included, the voucher journal entry made will automatically 

separate the freight amount. 

NOTE: If you are operating interactively with the CertiflexDimension 

Inventory program, freight amounts do not affect the inventory cost for 

inventory detail lines included. 

 Adjustment: You can use this field to adjust the invoice total for an amount that is not 

freight or tax. 

 Early Pay Discount: If the selected terms for this transaction include an early pay 

discount, you may manually adjust the early pay discount amount, if needed. If you 

manually change this amount, the system will discontinue the automatic early pay 

discount calculation for this order.  

[F3] Edit Journal Entry Distribution 

The system will automatically calculate the journal entry distribution for you 

based on the Purchase Codes used on the current order. You may optionally 

adjust any detail lines distribution by selecting this option. Distribution lines 

related to system purchase codes may not be edited. 

 Company: Enter the company ID for the selected journal entry leg. 

 Account: Enter the appropriate General Ledger account for the current entry leg.  To 

access the General Ledger accounts by account name, press F5.  To display a list of General 

Ledger accounts, press F6. 

 Debit Amount: 

Credit Amount: Enter the current journal entry leg’s amount in the correct field. 

 Accept: When an amount is entered, click >Accept to validate the entry leg. 

When the entry leg is validated, the system will update the Debits, Credits, and Balance 

total fields.  The Balance amount represents the total amount needed to balance the journal 

entry. 

 Edit: Click >Edit or double-click on a leg to edit an existing journal entry leg. 

 Delete: Click >Delete to remove the currently selected journal entry leg. 

 Balance: Click >Balance to automatically balance the journal entry. 

Once the journal entry is balanced, the system will allow you to click >Save to validate and 

save the journal entry General Ledger account distribution. 

Options 

 J.E. Description: Enter the description you want the system to post as the second 

description line to the General Ledger for this journal entry. The system will always post 

the vendor’s name as the first description line. 



35 

 

 The system will default to the description based on the options setting of Journal Entry 

Descriptions. If you do not want a second description line for this invoice, leave this field 

blank. 

 Check For Duplicates: If Check For Duplicates is selected and you enter a duplicate 

number, the system will display a warning message. You can have the system 

automatically check for duplicate transaction numbers by clicking Options and then 

clicking Check For Duplicates. 

The system will save the reference number to the open item created for this transaction. 

When this transaction is paid, the reference number is printed on the vendor's check stub. 

 Include Description Only Lines: Select this option if you wish to see 

description only lines displayed in the edit Quantities and Prices window. 

 Ask/Change Quantity: Select this option if you wish to be prompted for both quantity and 

extended prices when making changes to previously received detail lines. 

 Change Freight GL Account:   Select this option to change the General Ledger account 

that the freight amount for this transaction will be recorded to. 

 Change Adjustment GL Account:  Select this option to change the General Ledger account 

that the adjustment amount for this transaction will be recorded to. 

 Exclude Tax from Early Pay Discounts: Select this option if you wish to exclude the invoice 

tax amount from the early pay discount calculated amount.   

 Exclude Freight from Early Pay Discounts: Select this option if you wish to exclude the 

invoice freight amount from the early pay discount calculated amount.   

 Change Tax Rate/Status: Select this option if you need to change either the tax rate or tax 

status of the current invoice. 

Saving Your Voucher 

Once all voucher information is correct, click >Save to update the voucher.  Once you have 

recorded and saved all desired purchase order vouchers, click >Close to exit the Record 

Purchase Order Vouchers program.  The system will then prompt you to print the Voucher 

Transaction Listing.  
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Reviews – Purchase Order 

Reviewing Purchase Orders 

Reviewing purchase orders allows you to look up and review information about a purchase order 

without accessing the purchase order through the Transactions screen. When you need to 

verify information for a purchase order, you can use the Review option instead of the 

Transactions option.  

Reviewing a Purchase Order 

To review a purchase order, click >Reviews >Purchase Order >Review Purchase 

Orders. 

 

 Search: Enter a purchase order number into this field to locate it on the purchase order 

listing. 

Once located, the purchase order will be highlighted and its vendor information, date, 

amount, shipping address, and contact information will displayed in the corresponding 

fields to the right of the purchase order listing.  

 Type of Order: At the Review Purchase Orders screen, the system defaults to display your 

current open orders. To review closed orders, select Closed Orders from the Type of Order 

dropdown menu.  If you then need to review open orders, select Open Orders from the Type 

of Order dropdown menu. 

 Views: In addition to the open and closed purchase order listing, you can select from the 

following detailed and summarized views: 

o Open Order Summary: Displays a list of open orders, summarized per order. 
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o Open Order Detail:  Displays a list of open orders, with each line item detailed. 

o Closed Order Summary: Displays a list of closed orders, summarized per order. 

o Closed Order Detail: Displays a list of closed orders, with each line item detailed. 

 Quick Print Vendor or Shipping Label  : Allows you to print a user defined context 

label for the current account to a specific label printer.  For more detail information on 

configuring and/or changing Quick Labels for Vendors, Customer, Items and Orders, please 

refer to your CertiflexDimension System Manager Guide – Quick Print Labels. 

 Quick Copy Vendor Label  : Copies the selected order’s vendor information to your 

Windows clipboard. 

 Create New MyNote  : Allows you to record and attach a MyNote that will be associated 

with the selected order.  All of your MyNotes can be accessed from the main 

CertiflexDimension System Manager window.  For more information on how to get the 

most out of your MyNotes system, please refer to the MyNotes overview in your 

CertiflexDimension System Manager Guide. 

 

NOTE:  Since “Alternate Account Views” contain report totals, these options 

are only available to user having security access to both the “Review” and 

“Report” options per accounting system. 

To view detailed information, select the desired purchase order from the listing and click 

> Drill Down or simply double-click on the purchase order you wish to review.  The system 

will then display the Purchase Order Detail screen. 
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Purchase Order Detail 

The Purchase Order Detail screen displays information for the selected order.   

 

 

 

Additional Options 
 Notes, Links, and Memos: Click >Note, >Link, or >Memo to display the corresponding 

information for the selected vendor’s. 

For detailed information Notes, Links, and Memos, refer to the CertiflexDimension System 

Manager Guide. 

 Reprint Order: To reprint the selected order, click >Reprint Order. 

NOTE: The Reprint Order feature located in >Review Purchase Orders 

>Purchase Order Detail is the only way to reprint a closed order. 
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Reports – Purchase Order 

Standard Purchase Order Reports 

Printing reports in CertiflexDimension Purchase Order is an easy, yet powerful portion of the 

program. You can define the system to print almost any report based on almost any criteria you 

desire. 

To print a Standard Purchase Order Report, click >Reports >Purchase Order >Standard 

Purchase Order Reports and select the report you wish to print. Click >Options >Report 

Criteria to define the report specifications. 

Refer to your CertiflexDimension System Manager Guide for an explanation of each field on the 

Print Reports & Graphs screen and how to use the Sort/Selects feature. 

Below is a list of Purchase Order reports and the printing options available for each report.     

NOTE: Purchase Orders and Receiving Reports do not use the standard 

report printing options. These two reports are explained separately at the 

end of this chapter. 

Commitment Reports 

The Commitment Reports are available in four formats, by purchase order, by vendor, by 

expected receipt date, and by inventory item. Each report can also be printed in a summarized 

or detailed format. 

Each commitment report includes an Anticipated Receipts Schedule. This report reflects the 

dollar value of anticipated receipts aged by expected receipt date and provides anticipated cash 

requirements. 

We recommend that you print and review the commitment reports periodically to ensure that 

there are no canceled purchase orders remaining in the system. These reports also serve to 

assist you in making decisions regarding inventory stock levels. 

Commitment Report by Purchase Order Number, Vendor, and 

Item Number  

Report Criteria 

 Print Item Number: Select this check box if you want the system to include the 

inventory item number for each detail line item on the commitment report. The system will 

only include the item numbers when you are printing a Detailed Commitment Report or a 

Detailed - Open Only Commitment Report. 

 Report Type: Select which type of report to print. 

o Detailed: This report will print for all outstanding purchase order lines. The report 

includes quantities ordered, received, not yet received and vouchered, expected 

delivery date, unit price, and the commitment value for each purchase order line. 

Totals are provided for the quantity fields and the commitment value fields. 

o Summary: This report will print summarized information for all quantities ordered, 

received, not yet received, and vouchered. The commitment value is also provided in a 

summary format on this report. 

 Item Location:  If needed, define a range of item locations.  By default, the report will 

include all locations. 
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Commitment Report by Expected Receipt Date  

Report Criteria 

 Print Item Number: Select this check box if you want the system to include the 

inventory item number for each detail line item on the commitment report. The system will 

only include the item numbers when you are printing a Detailed Commitment Report or a 

Detailed - Open Only Commitment Report. 

 Report Type: Select which type of report to print. 

o Detailed: This report will print for all outstanding purchase order lines. The report 

includes quantities ordered, received, not yet received and vouchered, expected 

delivery date, unit price, and the commitment value for each purchase order line. 

Totals are provided for the quantity fields and the commitment value fields. 

o Summary: This report will print summarized information for all quantities ordered, 

received, not yet received, and vouchered. The commitment value is also provided in a 

summary format on this report. 

 Reporting Period: Select the period to report. If you select Date Range, the system will 

prompt you for the beginning and ending dates to report. 

 Item Location:  If needed, define a range of item locations.  By default, the report will 

include all locations. 

Commitment Report by Job Number 

Report Criteria 

 Print Item Number: Select this check box if you want the system to include the 

inventory item number for each detail line item on the commitment report. The system will 

only include the item numbers when you are printing a Detailed Commitment Report or a 

Detailed - Open Only Commitment Report. 

 Report Type: Select which type of report to print. 

o Detailed: This report will print for all outstanding purchase order lines. The report 

includes quantities ordered, received, not yet received and vouchered, expected 

delivery date, unit price, and the commitment value for each purchase order line. 

Totals are provided for the quantity fields and the commitment value fields. 

o Summary: This report will print summarized information for all quantities ordered, 

received, not yet received, and vouchered. The commitment value is also provided in a 

summary format on this report. 

 Item Location:  If needed, define a range of item locations.  By default, the report will 

include all locations. 

Closed Order by Vendor 

The Closed Order by Vendor report will display all closed purchase orders, in order of vendor 

number. 

Report Criteria 

 Print Item Number: Select this check box if you want the system to include the 

inventory item number in the Description column of the closed order report.  

 Include Job Number: Select this check box if you want the report to display the job 

number associated with the closed job, if applicable. 

 Item Location:  If needed, define a range of item locations.  By default, the report will 

include all locations. 

Closed Order by Item Number 

The Closed Order by Item Number report will display all closed purchase orders, in order of 

item number. 

 Print Item Number: Select this check box if you want the system to include the 

inventory item number in the Quantity Vouchered column of the closed order report.  
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 Include Job Number: Select this check box if you want the report to display the job 

number associated with the closed job, if applicable. 

 Item Location:  If needed, define a range of item locations.  By default, the report will 

include all locations. 

Voucher History 

The Voucher History report prints everything vouchered through the Purchase Order program 

in purchase code order. 

Report Criteria 

 Detailed: Select this check box if you want the report to include, for each detail line item 

vouchered, the date, purchase order number, vendor number, invoice number, description, 

quantity, and extended price in purchase code order. 

 If you do not select this check box, the system will print the totals for all detail line items 

vouchered to a purchase code in purchase code order and will include the code number, 

description, General Ledger account number, total quantity, and total extended price. 

 Reporting Period: Select the period to report for. If you select Date Range, the system 

will prompt you for the beginning and ending dates to report for. 

Voucher History by Job 

The Voucher History by Job report prints everything vouchered through the Purchase Order 

program that has been associated with a job. 

Report Criteria 

 Detailed: Select this check box if you want the report to include, for each detail line item 

vouchered, the date, purchase order number, vendor number, invoice number, description, 

quantity, and extended price in purchase code order. 

 If you do not select this check box, the system will print the totals for all detail line items 

vouchered to a purchase code in purchase code order and will include the code number, 

description, General Ledger account number, total quantity, and total extended price. 

 Reporting Period: Select the period to report for. If you select Date Range, the system 

will prompt you for the beginning and ending dates to report for. 

Purchase Code Listing 

The Purchase Code Listing lists each purchase code’s code number, description, taxable status, 

unit of measure, unit price, and General Ledger account number in purchase code order. 

Purchase Agent Listing 

The Purchase Agent Listing lists each purchasing agent’s code and name in purchasing agent 

code order. 
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Print Purchase Orders 

This report allows you to print all open purchase orders. The system will allow you to print the 

purchase orders as many times as necessary and on any schedule you desire. We recommend 

that you print all new purchase orders at the end of the day. You should also reprint any 

purchase orders that have changed. 

To print purchase orders, click >Reports >Purchase Order >Print Purchase Orders. 

 

 

 From: Select the purchase order you want to begin printing with. 

 To: Select the purchase order you want to finish printing with. 

 Include New Purchase Orders Only: Select this check box if you want the report to 

print only the purchase orders within the selected range that have not been printed before. 

If you want the system to print all purchase orders in the selected range, do not select this 

check box. 

 Selected Form: Select the form type you wish to use for printing. 

 Selected Printer: This section displays the printer currently selected. To change this 

setting, click Printer Setup. 

 Output: This section allows you to define where the report will print. 

o Selected Printer: Select this check box if you want the system to print the report 

to the selected printer. 

o Preview Screen: Select this check box if you want the system to print the report to 

the screen. 

NOTE: The system will allow you to select both check boxes. If you want to 

review a report to screen first and then want to print a copy, the system will 

allow you to do so from the preview screen. In addition, when printing from 

the preview screen, you can print a range of pages instead of printing the 

whole report. 

 Copies: Enter the number of copies of this report you want printed. 
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 Printer Setup…: This button allows you to select the printer to print the report. The 

system will default to your Windows default printer. If you want to change the printer for 

this report, click >Printer Setup… and select the printer from your Windows printer 

selection list. 
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Print Receiving Reports 

This report allows you to print reports that Receiving Department personnel can use to note 

quantities received for outstanding purchase orders. Each purchase order’s Receiving Report 

will begin printing on a new page. Purchase Order heading information such as vendor’s name 

and address, and the purchase order number and date are included on the Receiving Reports. 

Also included is the quantity not yet received, unit of measure, description, and stock number (if 

applicable) for each outstanding purchase order detail line. A space is provided beside each 

outstanding purchase order detail line for receiving personnel to note the quantity actually 

received. 

You use this report to aid you in recording receipts. 

To print receiving orders, click >Reports >Purchase Order >Receiving Reports. 

 

 From: Select the purchase order you want to begin printing with. 

 To: Select the purchase order you want to finish printing with. 

 Print Description Lines: Select this check box if you want the system to include 

description only purchase order detail lines. 

 Selected Form: Select the form type you wish to use for printing. 

 Selected Printer: This section displays the printer currently selected. To change this 

setting, click Printer Setup. 

 Output: This section allows you to define where the report will print. 

o Selected Printer: Select this check box if you want the system to print the report 

to the selected printer. 

o Preview Screen: Select this check box if you want the system to print the report to 

the screen. 

NOTE: The system will allow you to select both check boxes. If you want to 

review a report to screen first and then want to print a copy, the system will 

allow you to do so from the preview screen. In addition, when printing from 

the preview screen, you can print a range of pages instead of printing the 

entire report. 

 Copies: Enter the number of copies of this report you want printed. 
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 Printer Setup…: This button allows you to select which printer to print the report. The 

system will default to your Windows default printer. If you want to change the printer for 

this report, click Printer Setup… and select the printer from your Windows printer 

selection list. 
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Purchase Order WorkSheet Reports 

Using WorkSheet Reports in CertiflexDimension is an easy, yet powerful portion of the 

program.  You can use this system to create almost any interactive WorkSheet you desire. 

 

To use a Purchase Order WorkSheet Report, click >Reports > Purchase Order 

>WorkSheet Reports. 

 

The system will display a WorkSheet Listing for your selected module.  Select the WorkSheet 

you wish to use and click > Create. 

 

NOTE:  Each WorkSheet can be saved in three different styles.  The system 

will always start with the “Default” style saved for this WorkSheet.   

The options for formatting and printing WorkSheets are the same in all systems.  For detailed 

information about each of these specific functions, please refer to your CertiflexDimension 

System Manager Guide – WorkSheet Reports. 

WorkSheets 

Below is a list of WorkSheet Reports available for this module. 

 Open Order Summary 

 Open Order Detail 

 Closed Order Summary - MTD     

 Closed Order Summary - YTD     

 Closed Order Detail - MTD     

 Closed Order Detail - YTD  
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Compressing Data Files 

Compress Closed Vendor Orders and Purchase Code 

Detail 

Compressing vendor orders and purchase code detail files allows you to remove old order and 

detail information from the system’s data files. You would periodically choose this option to 

remove old information that is no longer needed or wanted. 

We recommend that you perform this option as part of the year-end processing procedures. For 

example, if the company needs to have the last two years of transaction information on file, at 

the beginning of each year, you would compress the unneeded year. 

To compress the vendor order and purchase code detail information, click >File >Data File Maintenance 

>Compress Data Files.  The Compress History Wizard screen will be displayed.  Click >Next to 

continue. 

 

 File List: Select the data file to compress. For the closed vendor orders, select POC – Closed 

Vendor Orders.  To compress purchase code detail, select PO4 – Purchase Code 

Detail.  Click >Next. 
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 Compression Type: This selection allows you to compress all completed orders or 

canceled orders from previous years. 

Click >Next. The system will display a screen detailing the information selected to compress. 

To begin the compression, click >Compress. 

NOTE: Make sure that you have at least two good backups of the data files 

before you begin compression. Once compression begins, you must allow the 

system to complete the process. If you experience a power failure, or if 

anything interrupts the compression process, the system will require you to 

restore a backup. 

If you are operating on a network, make sure that all users have logged off 

CertiflexDimension. The compression program will not operate properly if 

there are users other than the one initiating the compression process logged 

on to the CertiflexDimension program. 

The amount of time the compression program takes is dependent upon the number of orders 

currently in the file and the processing speed of your computer. We recommend that you do not 

perform this option during the busy part of your day because after you start the compression, 

you cannot stop it for any reason without having to restore a backup. 

Once the compression program is complete, all orders and code detail through the selected order 

number that met the compression criteria will have been deleted. You will not be able to access 

that information again without restoring a backup. 
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